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Abstract

In this chapter, we delve into the sophisticated realm of multivariate statistical methods, focusing on
Principal Component Analysis (PCA) and Projection to Latent Structures (PLS), as pivotal tools for
unraveling the complexity of process data analytics. By anchoring these statistical techniques within the
framework of polyethylene manufacturing processes, we aim to illuminate their exceptional utility and
novelty in addressing the multifaceted challenges inherent in process optimization and quality control.

The discourse begins by introducing PCA, not merely as a statistical tool, but as a fundamental
cornerstone for the analytical examination of process variables. Through a meticulously designed
workshop, we demonstrate the application of PCA in dissecting the intricate web of variables influencing
the quality and conversion rates of Low-Density Polyethylene (LDPE) production in a two-zone tubular
reactor. The integration of Aspen ProMV as a practical tool for PCA applications exemplifies the
seamless bridge between statistical theory and industrial application, emphasizing the method's
accessibility and relevance to both academia and industry.

Transitioning to PLS, the chapter articulates its differentiation from PCA by its ability to simultaneously
handle datasets comprising both process variables (X) and product quality variables (Y), offering a
holistic view of the manufacturing process. Through pragmatic workshops, we showcase PLS's
robustness in application to challenges such as melt index prediction and causal analysis in High-Density
Polyethylene (HDPE) manufacturing, underscoring its adaptability to complex industrial datasets,
including those with measurement time lags.

The exploration extends to the nuanced application of these multivariate statistical methods to batch
polymer processes. Here, we introduce a novel batch-wise unfolding approach via multiway PCA and
PLS, expanding the frontier of statistical applications in process data analytics.

This chapter transcends the conventional boundaries of statistical applications, highlighting the
transformative impact of PCA and PLS in the domain of process data analytics. It aspires to foster a
deeper understanding and appreciation of these statistical methods, encouraging their broader
adoption and adaptation in optimizing manufacturing processes and enhancing product quality. This
contribution not only reaffirms the critical role of advanced statistical techniques in the scientific
community but also underscores their practical significance in improving industrial operations and
outcomes.

This is a preprint version of a chapter from our book - Integrated Process Modeling, Advanced Control
and Data Analytics for Optimizing Polyolefin Manufacturing. Please cite the original work if referenced
[31,32].

9.1 Introduction to Principal Component Analysis (PCA)

This Chapter 9 focuses on the use of multivariate statistics. Sections 9.1 introduces an important
multivariate statistics tool in process data analytics, namely, principal component analysis (PCA). Section



9.2 presents a hands-on workshop on the application of PCA for analyzing the process variables that
affect quality and conversion of LDPE product from a two-zone tubular reactor. We introduce the use of
the software tool, Aspen ProMV, for multivariate statistics applications, available to universities at low
cost. Section 9.3 introduces the projection to latent structures or partial least squares (PLS). A key
difference between PCA and PLS is that PCA involves only datasets of process variables (X) or deals with
the X-space; PLS involves datasets of both process variables (X) and product quality variables (Y), or
deals with both X-space and Y-space. Section 9.4 presents two hands-on workshops of applying PLS to
the LDPE problem of Section 9.2, and to the melt index prediction and causal analysis of a HDPE
manufacturing process. Section 9.5 introduces PLS for process data analytics with measurement time
lags and includes a hands-on workshop of PLS for a HDPE process for the melt index prediction and
causal analysis, including the effect of time lags on melt index measurements. Section 9.6 covers the
process data analytics for batch polymer processes and presents a hands-on workshop to demonstrate
the multiway PCA and PLS methodology, particularly the batch-wise unfolding approach, for data
analytics. Section 9.7 gives the bibliography and suggested further reading

Beginning in late 1980 to early 1990, chemical engineers have been paying an increasing attention to the
emerging topics of artificial intelligence, neural computing, multivariate statistics, machine learning and
big data analytics, and their applications to bioprocessing and chemical engineering [1 to 5]. MacGregor
and others have demonstrated the significant applications of multivariate statistics and big data
analytics to optimizing the manufacturing of LDPE, HDPE, Nylon 6 and other polymers [6 to 10].
Multivariate statistical analysis [11 to 13] and its implementation using languages such as Python, R or
software such as Aspen ProMV, SAS, JMP, etc. find a growing number of applications to polymer
manufacturing. These include: (1) data quality deviation analysis; (2) unit yield analysis; (3) production
capacity degradation analysis; (4) offline production optimization (discovery and optimization of key
variables); (5) online process monitoring and troubleshooting; and (6) batch process variable analysis.

This section introduces the principal component analysis (PCA), following the multivariate statistical
analysis textbooks of Johnson and Wichern [11], and Rencher and Christensen [12], and the excellent
online book of Dunn [13], which is continually updated. The online reader is allowed “to freely
download, share, adapt, commercialize and attribute” some of the book materials, as long as the reader
acknowledges that “Portions of this work are the copyright of Kevin Dunn”. That is exactly what we wish
to acknowledge here, as we shall use some of the explanations and figures from reference [13] below.

Both textbooks [11,12] include a chapter of matrix algebra relevant to multivariate statistical analysis.
Therefore, we have included an Appendix A, Matrix Algebra in Multivariate Data Analysis and Model-
Predictive Control Using MATLAB and Python at the end of this book. This appendix also includes the
basic implementation of the relevant matrix operations and principal component analysis in both
MATLAB and in Python.

9.1.1 Introduction to Principal Components

We follow [14] to illustrate the concept of principal components. Figure 9.1 shows a 3D image of some
process data. When projecting the same data onto a 2D plane in Figure 9.2, we are unable to observe
the same 3D relationship. However, we can observe sufficient characteristics of the original 3D image in
two dimensions if we can identify two linear combinations of process variables x, y and z in order to
capture most of the variations in these three process variables. See Figure 9.3.



Example 3D Image

Figure 9.1 The original 3D image of process data. Used with perssion from Aspen Technology, Inc.

Figure 9.2 Losing the characteristics of the original 3D image when projecting onto the x-y plane. Used
with perssion from Aspen Technology, Inc.
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Figure 9.3 Retaining the characteristics of the original 3D image when displaying on the two-dimensional
plane of latent variables LV1 and LV2 (or principal components 1 and 2). Used with perssion from Aspen
Technology, Inc.

In Figure 9.3, we see the characteristics of the original 3D image on a two-dimensional plane of two
linear combinations (LV1 and LV2) of the process variables (x, y and z):

LV1=0.1658 x + 0.6120y + 0.7733 z (9.1a)



LV2 =-0.9652 x + 0.2615 y (9.1b)
We call these linear combinations the latent variables or principal components of the process variables.

Principal component analysis (PCA) is a data transformation method that rotates data such that the
principal axis of the data is in the direction of maximum variation. See Figure 9.4. We follow the
interpretation of [15] here. The first latent variable or first principal component of the process data or
observations given by Eq. (9.1a) represents the linear combination of the original process variables
whose sample variance (see Appendix A, Section A.1.6) is greatest among all possible linear
combinations. The second latent variable or second principal component represents the linear
combination of the original process variables that accounts for a maximum proportion of the remaining
variance, subject to being uncorrelated with the first principal component. We can define subsequent
principal components similarly.
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Figure 9.4 An illustration of the principal component that shows the direction of
maximum variation of the process data

We can view the rotated data on the new principal axes (components). We call the coordinates of the
data in this new coordinate system as principal component scores. They are essentially the projection of
the data onto the principal axes. As seen in Figure 9.4, the principal components are essentially vectors
in the original variable space, and these vectors are called principal component loadings. We quantify
both the principal component scores and loadings, and their relationship to the original process data
matrix in the following section.

9.1.2 Data Preprocessing: Mean-Centered and Scaled Process Data Matrix X, Principal Component
Score Matrix T, and Principal Component Loading Matrix P

We follow [13] for the development of the PCA model. Let us consider a J x K process data matrix X, with
K columns of process variables x« (k=1,2 ,..., K), and with each variable x having J observations or
measured values, Xik, X2k, X3k, ...Xi (OF Xj, j = 1, 2,..., J).  In Appendix A, Section A.1.7, we introduce the
standardized data matrix, or mean-centered and scaled data matrix Xs, and the correlation coefficient
matrix R from the process data matrix X.

To correctly carry out PCA, we first preprocess the data. Specifically, we start with a data
standardization step to convert the process data matrix X to a standardized data matrix Xs that is mean-
centered and scaled by standard deviation [11,13]. For convenience in eliminating the letter “s” from a
mean-centered and scaled data matrix Xs, we assume in the following discussion that our process data
matrix X has already gone through a standardization procedure described in Appendix A, Sections A.1.5



to A.1.7. As we demonstrate in Appendix A, it only takes a single command using Matlab [zscore(X)] or
Python [stats.zscore()], to standardize a process data matrix X.

9.1.3 Development of PCA Model
We write the standardized data matrix X as a matrix of K process variable vectors:
X11 vt X1k
X =[X1 X2 cerenee x| = [ oo ] (9.2)
le e xjk

In this matrix, the k-th process variable vector xk is a (J x 1) column vector, [Xik, X2k, X3k, ...Xi ]’, where J is
the number of samples or measurements. The transpose of xk, or xi’, is a (1 x J) observation vector.

Figure 9.5 illustrates the projection of the vector xx onto the first principal component vector p1. The
score value tx1 for this observation vector is the distance from the origin along the principal component
loading vector, p1, to the point where we find the perpendicular projection onto p; [13].
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Figure 9.5 The projection of the kth process variable vector xx onto the first principal
component loading vector p1. tk1 is the score value of xx on pi.

We can write from geometry that: (1) the cosine of an angle in a right-angled triangle is the ratio of the
adjacent side to the hypotenuse; (2) the cosine of the defines the dot product of two vectors. See Egs.
(9.3) and (9.4):

cos 0 = (adjacent length)/(hypotenuse) = tx1 / || Xk || (9.3)
cos 8 =x pr/ || xic [l [l pe |l (9.4)

where || - || represents the length of the enclosed vector, and the length of the principal component
loading vector, || p1 || is 1.0. Therefore, we find:

t1= X pP1 =Xk1 P11+ Xk2 P2,1 + oot Xij Pj1 e T+ Xk P2 (9.5)
Likewise, we write
ti2 = X’ p2

= Xk1 P12 + Xi2 P22 + oot Xk Pj2 -oon + XiJ P12 (9.6)



Generalizing Eq. (9.5) and (9.6), we write the principal component score vector ti resulting from

projecting the process data vector xx onto A principal component loading vectors, expressed by the (K x
A) loading matrix P:

t’=x/P (97)
(1xA)=(1xK)(KxA)

Lastly, we can represent the projection of the entire process data matrix X in terms of a principal
component score matrix T and a principal component loading matrix P:

T=XP (9.8)
(IxA)=(xK)(KxA)

where J is the number of samples or measurements, A is the number of principal components, and K is
the number of process variables.

9.1.4 Prediction Errors from PCA Model

Figure 9.6 illustrates the projection of the original data vector xxonto the first principal component
vector p1. The best estimate of x« is a vector Xy, along the first principal component loading vector p;
where the original vector is projected. We call this estimate of the data vector, X, 1. We note the
distance along the first principal component loading vector ps is the principal component score tx .
Based on vector geometry, we represent the error between x¢ and X, 1as an error vector e
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Figure 9.6 The projection of the kth process variable vector xx onto the first principal component vector
p1, indicating an estimate of the data vector X 1, together with an error vector exa. t«1is the score
value of xx on p1.

We write the prediction vector as:
X} 1= tap's (9.9)
(1XK) =(1x1)(1xK)
and the corresponding prediction error vector is:
e’k =Xk - Xpq (9.10)

(1xK)=(1xK)—(1xK)



Adding the second principal component vector p;, we generalize the prediction vector from Eq. (9.9) as:

Xp2= k1’1t 2P’ (9.12)
(1xK)=(1xK)+(1xK)

where t1 and ti,are the score values of xx2 on p1 and p», respectively.

Extending Eq. (9.11) to A principal component vectors, we write the projector vector of the original data
vector xx onto the A principal component loading vectors [p1 p2 ......pa] or principal component loading
matrix P, with ti being the score vector:

f;ul: [te1 tea..., tea P’ = '« P’ (9.12)
(1xA)=(1xA)(AxK)

We generalize Eq. (9.12) to represent the entire data prediction matrix X in terms of the score matrix T
and the principal component loading matrix P:

X=TP (9.13)
(IxK)=(xA) (AxK)

We define the residual vector exafor the k-th process variable using A principal components as the
difference between the actual and predicted observations:

e'ka=Xi-Xj 0= Xi-t'P’ (9.14)
(1xA)=(1xA)-(1xA)

Referring to Figure 9.7, we define the row residual or the squared prediction error (SPE) for k-th process
variable as:

SPEx= (€’ €k a)?
= [ (X1— Ri 1) + (X2 = R ) vt (Xica— R )22 (9.15)
The corresponding vector representation of all SPE, (k= 1,2 ...K) for all K process variables is
SPE = [ SPE; SPE,..., SPE |’ (9.16)

We write Eq. (9.14) as a prediction error or residual matrix E for all K process variables, J observations
per variable, and A principal component loading vectors [p1 p2 ......pa] or principal component loading
matrix P as follows:

E=X-X =X-TP or X=TP+E (9.17)

Figure 9.7 illustrates the relationship between E, X, X, and SPE.
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Figure 9.7 An illustration of the relationships among the prediction error matrix E, process variable
matrix X, predicted process variable matrix X, and squared prediction error matrix SPE.

In Figure 9.7, each row of E contains the row residual or the prediction error for j-th observation (j= 1,2,
...J) for all K process variables.

Figure 9.8 shows a similar plot, focusing on the column residual, or the prediction error for each column
that represents the k-th process variable (k= 1,2, ...K) in the residual matrix E [13].
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Figure 9.8 An illustration of the relationships among the prediction error matrix E, process variable
matrix X, predicted process variable matrix X, and column or the prediction error for k-th process
variable (column)

Each column of E contains the prediction error for one variable. Referring to the discussion of least
squares model analysis on pages 165 to 168 of [13], we can find the R?value for the k-th process variable
(column) as:

_ Var(xy _X,) _ Var(eg)
Var(xg) - Var(xg)

(9.18)

The R2 value for each process variable will increase with every principal component that is added to the
model. The minimum value is 0.0 when there is no principal component and Xj, = 0. The maximum value
is 1.0 when we have added the maximum number of principal components with x, = X, ande, = 0.

We can extend the preceding row residual and column residual concepts to the whole process data matrix
X and calculate the R?value of the entire matrix [13]. This value is the ratio of the variance of X that we can
explain with the PCA model over the ratio of variance initially present in X.

_Var(X-X) _. Var(E)

1- (9.19)

2 _
R°=1 Var(X) - Var(X)

By using ML or Python (see Appendix A), or Aspen Technology’s software Aspen ProMV, we can evaluate
the R?value and identify the number of principal components needed to adequately explain the data



variability in X. We have demonstrated this aspect in Appendix A and will illustrate this aspect in our
hands-on workshop WS9.1, in which Aspen ProMV shows the R?value as R2 for different number of
principal components.

Lastly, page 380 of Dunn [13] explains the concept of determining the number of principal components
to use in a model based on cross-validation (CV), originally proposed by Wold [20]. We follow Dunn’s
exposition below.

The general idea is to divide the process data matrix X into G groups of rows. These rows should be
selected randomly but are often selected in order: row 1 goes in group 1, row 2 goes in group 2, and so
on. We can collect the rows belonging to the first group into a new matrix called X, and leave behind
all the other rows from all other groups, which we will call group X-3. So in general, for the g-th group,
we can split matrix X into X(g) and Xi-g) . Wold'’s cross-validation procedure asks to build the PCA model
on the data in X(-y) using A components. Then use data in X(3) as new, testing data. In other words, we
preprocess the X rows, calculate their score values, Ty = X)P, calculate their predicted values, X =
TwP', and their residuals, Eq) = Xy - X1). We repeat this process, building the model on Xz and testing
it with X2, to eventually obtain E). After repeating this on G groups, we gather up Ey, E3, . .., Eg and
assemble a type of residual matrix, E4,cv, where the A represents the number of components used in
each of the G PCA models. The CV subscript indicates that this is not the usual error matrix, E. From this,
we can calculate a type of R2 value. We do not call this R2, but it follows the same definition for an R2
value. We will call it Q24 instead, where A is the number of components used to fit the ¢ models.

Q24 =1-Var(Ey, cv)/ Var(X) (9.20)

Essentially, Q24 is a measure of how well the process variables will be predicted with new data
calculated by cross validation. In our hands-on workshop WS9.1, Aspen ProMV shows the Q?value as Q2
for different number of principal components with cross validation.

9.1.5 Hotelling’s T?value from PCA Model

In Figure 9.6, we illustrate the score value tx1 of process variable vector xxon the first principal
component p;. Let tca (k=1,2...K; a=1,2,....A) be the score value of kth process variable xx on the a-th
principal component, and s, (a= 1,2,...A) be the variance of the a-th principal component. Then, the
Hotelling’s T? value for the k-th process variable is:

T2=3 (tka/sa)? (9.21)

T2value is a positive, scalar number that summarizes all the score values. It represents the distance from
the center of the hyperplane of process variables to the projection of the sample onto the hyperplane.
For samples that are very close to the sample mean gives a T? value of zero [15].

Figure 9.9 illustrates the concept of Hotelling’s T? value for an example with two principal components
(A=2):
tf

2= + 2 (9.22)
sl



Figure 9.9 An illustration of the concept of Hotelling’s T? value in a two-latent-variable
or a two-principal-component space, t, versus t;

In the figure, the equation for T?, Eq. (9.21), is that of an ellipse. T? expresses how far an observation is
from the center of the model in the plane. All points on the ellipse have the same T2 value.

We note that references [11,15], among others, have presented the detailed development, showing that
the variances of principal components s, (a=1,2,...A) are actually the eigenvalues of the correlation
coefficient matrix R, which is introduced in Appendix A, Section A.1.7, and Eq. (A.24), based on the
standardized data matrix Xs. Additionally, the eigenvectors of R correspond to principal component
loading vectors pa (a= 1,2 ...A). Extracting principal components as the eigenvectors of R is equivalent to
calculating the principal components from the original variables after each has been standardized to
have zero mean and unit variance [13], as we discussed in Appendix A, Sections A.1.5to A.1.7.

In Appendix B of this book, code B.8 and Table B.1 at the end give the Python implementation of the
PCA algorithm, together with a list of common parameters and their suggested values.

9.2 Workshop 9.1: PCA of the Process Variables Affecting the Quality and Conversion of LDPE Product
from a Two-Zone Tubular Reactor

We demonstrate the development of a PCA model for analyzing the quality and conversion of a two-
zone tubular reactor for producing low-density polyethylene (LDPE). The problem comes from
references [6,18], and the process data for LDPE are available in [19]. We use Aspen Technology’s
multivariate statistical analysis software, Aspen ProMV, for this workshop. The LDPE production process
is similar to the process defined by Sharma & Liu.

Figure 9.10 shows a schematic diagram of the two-zone reactor, and Table 9.1 defines the 14 process
variables (X) and 5 product quality variables (Y).
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Figure 9.10 A schematic diagram of a two-zone tubular reactor for producing LDPE

Quality variables (Y)

Table 9.1 Process and quality variables for workshop 9.1 [18]

Process variables (X)

Conv

Cumulative conversion

TmaxlaTm axd

Maximum temperature of the reaction mixture (K)
(subscripts 1 and 2 refer to zones 1 and 2)

MWN

of the monomer
Number-average

Touy, Tou

Outlet temperature of the reaction mixture (K)

MWW

molecular weight
Weight-average

TClnla TEinZ

Inlet temperature of the coolant (K)

LCB

molecular weight
Long chain branching

4,2

Axial reactor length of Tyau and Traxe
(% of the reactor length)

SCB

per 1,000 carbon atom
Short chain branching

Fi1, Fiz

Flow rate of the initiator (g/s)

per 1,000 carbon atom

Fsy, Fs2

Flow rate of the solvent in the inlet feed and in the
intermediate feed (% of the ethylene flow rate)

Tin

Inlet temperature of the reaction mixture (K)

Press

Reactor pressure (atom)

Step 1. Start Aspen ProMV. Select new projects. See Figure 9.11.

*The outlet temperature of the coolant in two zones is fixed.
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Figure 9.11 Choose New project in Aspen ProMV.
Step 2. Load the process data file and save the project file.

Click on Add/Edit Data and Import from File, LDPE.xIs. Choose Process Variables only. See Figures 9.12.
Figure 9.13 displays a portion of the imported process variable data. By clicking OK twice, we see the
Standard Data Specification. See Figure 9.14. We then click OK and see the observation summary of
Figure 9.15. Highlight the observation ID column to include all observations and the Include observations
button turns “green” to indicate that we have included all observation data. See Figure 9.16. Click OK.
Save the project as W59.1_PCA-X.pmvx. See Figure 9.17.
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Figure 9.12 Import process data from file, LDPE.xls, and choose process variable worksheet only
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Figure 9.13 A display of imported process variable data
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B Observation Summary — O =

In/Del Obs|D Standard Data

380
39.0
40.0
41.0

Colour Legend
420 Observation In Block
43.0 [ observation Not In Block
44.0 Include/Delete Observations
45.0

@ include M Delete

46.0
47.0 Arrange Observations
48.0 Move Up
49.0 Move Down

50.0
51.0
52.0

53.0

54.0 ~

| oK | | cancel




Figure 9.15 A display of observation summary
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Figure 9.16 Highlight all observations to include them in the model development
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Figure 9.17 Saving the Aspen ProMV project file as W59.1_PCA-X.pmvx.

Step 3. Build a PCA model for process variables X.

After saving the project file, we see the New Model dialog. We click on the Blocks/Variables name,
“Process Variables”, to display the 14 process variables. Both the Block name and Variable names are in
green. See Figure 9.18. In the figure, “MC” and “UV” represent the preprocessing of data to make them
Mean-Centered with Unit Variance Scaling, as we discuss in Appendix A, Sections A.1.5 and A.1.7 for
standard data matrix. “Custom” in the figure refers to Custom Scaling, that is, the variables will be
multiplied by this custom value after we have applied data centering and scaling.

We then click OK, and fill in the model name, WS59.1_PCA-X.pmvx. See Figure 9.19. Select Model ->
Active Model ->Auto Fit -> See Figure 9.20. Figure 9.21 shows the resulting R2 and Q2 values, Egs. (9.18)
to (9.20), versus the number of principal components. We can right-mouse-click on this plot and select
“Create Table” to see a table of R2 and Q2 values in the plot, as seen on the right of Figure 9.21.
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Figure 9.18 Process variables (X) for developing a PCA model on X
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Figure 9.19 Filling in model name, WS9.1_PCA-X.pmvx.
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Figure 9.20 Auto-fitting the PCA model with the number of principal components (A) equal to half of the
number of process variables (N=14), A= 14/2 =7.
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Figure 9.21 R2 and Q2 values versus the number of principal components.

Figure 9.21 shows the cumulative R2 and Q2 values for each model component. The R2 of the final
component is the total amount of the variability in the dataset that the model explains, and the Q2
value of the final component is a measure of how well the dataset is predicted by unseen data in cross
validation. If the R2 and Q2 values are low, it could mean that there is significant noise in the data,
existence of significant outliers, or not enough information in the data to fit an acceptable model. The
figure indicates that increasing the number of principal components or latent variables, increses the R2
value, as explained previously in Section 9.1.4. With 7 principal components, an R2 value of 0.9149 says
that the PCA model can explain 91.49% of the variability of the dataset for process variables (X).
Likewise, with cross validation, a Q2 vale of 0.8406 says the model can explain 84.07% of the variability
of the dataset for process variables.

Task 4. Generating PCA plots and their interpretations.

We follow the Aspen ProMV online help section on Interpreting Plots to demonstrate some useful plots
and their interpretations.

(1) Model summary (R2 and Q2) plots for a selected maximum number of principal components

Choose the # button in the middle of the top of the screen, and fill in a maximum number of 4 principal
components, we get a R2-Q2 plot of Figure 9.22.
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Figure 9.22 R2-Q2 plot with a maximum number of 4 principal components
(2) Variable summary plot

We follow the path: Analyze -> Model -> Variable summary ->Block: Choose X-space, and Component:
Choose 7, and see Figure 9.23. We also right-mouse-click on this figure and select “Create Table” to see
a table of R2 and Q2 values in the figure, as seen on the right of Figure 9.23. This figure shows the total
R2 and Q2 of each X variable in a PCA model. As explained previously with Figure 9.21, if there are many
variables and a few variables are not predicted well, this may mean there is no information in the
dataset that can well explain these variables, not enough variation in the variables, too much noise, or
significant outliers.
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Figure 9.23 Variable summary plot in the X-space in a PCA model

(3) “Components by variable” plot



We show Figure 9.24 by following the path: Analyze -> Model -> Components by variable ->Block:
choose process variables, and Variable: choose Tin (displayed in Figure 9.10, inlet temperature of the
reaction mixture). This figure shows the R2 and Q2 values for all of the components for a specific X or Y
variable. In this case, it is the X variable, inlet temperature, Tin.
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Figure 9.24 R2 and Q2 values for all components for a specific X or Y variable
(4) T1-T2 score plot and P1-P2 loading plot

We discussed in Section 9.1.4 of the score matrix T and the loading matrix P. In Appendix A, Section B.4,
we demonstrate the use of ML to generate these matrices. By choosing T1-T2 and P1-P2 buttons on the
left side pane, we generate the score plot and loading plot of Figure 9.25. These figures plot the score
and loading values of the second principal component, T[2] and P[2], versus those of the first principal
component, T[1] and P[1].

The scores are the latent variables, which are the weighted averages of the original process variables,
X’s. The score plot enables us to find clusters (such as in the middle of the left score plot in Figure 9.25)
and outliers (such as observation 54). On the score plot, the inner dashed ellipse represents 95%
confidence limit, while the outer solid ellipse represents 99% confidence limit. Observations that fall
outside the 95% or 99% confidence intervals may be outliers; however, 5% and 1% of the observations
are expected to naturally fall outside of the 95% and 99% confidence intervals, respectively. This plot
shows the scores for a PCA model where there are both data clustering and a possible outlier.

The loadings are the model variables that explain the relationship between the X variables in PCA (or X
and Y variables in the case of PLS discussed in Sections 9.3 and 9.4) and the latent variables (scores). In
the right loading plot of Figure 9.25, variables that are close to the center of the plot are not significant
for explaining the variation in the plotted components. By contrast, variables that are far from the
center are important for explaining the variation in the dataset. Variables that are close together on the
loading plot are correlated and variables that lie on the opposite sides of the plot are negatively
correlated.
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Figure 9.25 T[2] vs T{1} score plot and P[2] vs P[1] loading plot

(5) Hotelling’s T2 plot
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Select the Hot’s T2 button on the left side pane. We see the Hotelling’s T2 plot of Figure 9.26. This plot
measures the deviation of an observation from the origin, that is, from the average operating point.
Note the two horizontal lines labelled 0.99 and 0.95 for 99% and 95% confidence limits. We see
observation #54 lie above the 95% confidence limit. This is acceptable, as there are generally on average
5 out 100 observations lying outside the 95% confidence limit.
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Figure 9.26 The Hotelling’s T2 plot

(6) Row residual or squared prediction error SPE-X plot




We discussed the SPE in Egs. (9.15) and (9.16) and in Figure 9.7. Choosing SPE-X button on the left side
pane gives the SPE-X plot of Figure 9.27. In the plot, we see that observation 54 has the largest SPE

value.
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Figure 9.27 The SPE-X plot

(7) Variable importance to projection (VIP) plot

Choosing VIP button on the left side pane gives the VIP plot of Figure 9.28. The VIP plot gives a
guantitative metric of the relative importance of a variable to a PCA model. A rule of thumb is that
Variables with a VIP value close to or greater than 1 are important. Referring to Figure 9.10 and Table
9.1 for the definitions of process variables, we see that Tout1, Tmaxz, Tein1, and Teinz are four most important

process variables in the PCA model.
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Figure 9.28 Variable importance plot.

(8) Contribution plots

When a single observation is selected on a score plot or Hotelling’s T2 plot, the contribution plot shows
the difference between that observation and the average observation. Following the path: Analyze ->
Contributions ->This opens the contribution plot window. In this window, we specify analysis between



our apparent outlier, observation 54, and the average observation using the specifications shown in
Figure 9.29, left. These inputs yield the contribution plot on the right side of Figure 9.29. We see that z2
(the axial reactor length at the maximum temperature of the reaction mixture in zone 2, Tmax2, Figure
9.10) is higher than the average, and Tmax2 is lower than the average.
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Figure 9.29 Point-to-average contribution point.
This concludes workshop WS9.1_PCA-X, and we save the file as W59.1_PCA-X.pmvx.
9.3 Partial Least Squares or Projection to Latent Structures (PLS)
9.3.1 Introduction to PLS

When applying data analytics to chemical processes, we often deal with not only process variables and
their measurements, but also focus on quality or productivity variables. Let X be a JxK process variable
matrix with K columns of process variables (k=1 to K), and J rows of measurements per variable (j=1 to
K), and Y be a JxXM process quality variable matrix with M columns of quality variables (m =1 to M), and J
rows of measurements per variable (j = 1 to J).

As discussed in Section 9.1.1, PCA rotates the process data such that the principal axis of the data
represents the direction of maximum variation. The projection of the data in the new coordinate system
of A principal components is called the principal components or latent variable scores, which are
represented by a JxA score matrix T, where J represents the rows of measurements per variable, and A
denotes the number of principal components. Additionally, the principal components are vectors in the
original variable space, and we call these vectors principal component or latent variable loadings, which
are represented by a (KxA) principal loading matrix P, where K represents the number of process
variables and A is the number of principal components.

Since PCA only uses X-data to find the principal component scores, T, these components explain
variation in X-data, and not necessarily the most predictive of Y-data. In this section, we wish to use
both X-data and Y-data simultaneously to identify the latent variables that explain the variation in X and
are predictive of Y.

In Figure 9.30, we decompose the standardized J x K process variable matrix X and J x M product quality
matrix Y into their principal component loading vectors (p. and c,, a = 1,2 ...A), and principal component



score vectors (taand u,; a =1, 2, ...A). Alternatively, we can express the entire process variable matrix X
in terms of a principal component loading matrix P, a principal component score matrix T, and a
prediction error or residual matrix E, as seen previously in Eq. (9.17). Likewise, we represent the entire
product quality matrix Y in terms of a principal component loading matrix C, a principal component
score matrix U, and a prediction error or residual error matrix F. See Eq. (9.23).

X =TP+E =X+E (9.17)
(I xK)=(xA)(AxK)
Y =UC+F =Y +F (9.23)

(IxM)=(xA)(AxM)

Keol Acol Acol Mol
T
x (JxA) Y
—_—
(IxK) U (JxM)
(JxA)
Jrow Jrow Jrow JRow
Ko \t\t \\ Mcol
A
w50 S
Acol
(AxM)
w’
(KxA)
KRow

Figure 9.30 An illustration of partial least squares (PLS) regression of both process variable matrix X and
product quality matrix Y, their principal component loading matrices P and C, and score matrices T and
U, together with the weight matrix W’ for relating the score matrix T with process variable matrix X [13].

We can estimate the X-scores (i.e., principal component score vectors t.’s or principal component score
matrix T) as linear combinations of the original process variable vectors xi (k=1,2 ...K) with the
coefficients, “weights”, w

tja= 2 X jk Wka or T=XW (9.24)
9.3.2 Nonlinear Iterative Partial Least Squares (NIPALS) Algorithm

We follow [13,16,17] to show how to compute the principal components sequentially and to handle
missing data, with reference to the steps involved in Figure 9.31 [13].
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Figure 9.31 An illustration of the steps involved in computing the principal components by the NIPALS
algorithm [13].

Step 1. See the number or the numbered arrow direction in Figure 9.31 for the numbered step. Begin
with the J x K process variable matrix X and J x M process quality matrix Y. X, and Y, are both
preprocessed versions of the raw data when the number of principal components a equal to 1.
Select a column y, within the quality matrix Y as our initial estimate for a score vector u..
Regress a data column x, within data matrix X onto a score vector u, within score matrix U. Store
the regressed slope coefficients in the weight vector w,. Large weight coefficients reflect that
columns in X, are strongly correlated with u,. We do this regression as follows:

W,= (1/ uy’ul) Xa’ u, (9.25)
Step 2. Normalize the weight vector to unit length.
Wa= W/ (Wa'wa)Y? (9.26)

Step 3. Regress every row in X, onto the weight vector wa,. Store the regressed slope coefficients in the
score vector t.. Repeat doing this for all J rows of observations:

ta= (1/ wa'wa) X' w, (9.27)

Step 4. Regress every column in Y, onto the vector t.. Store the regressed slope coefficient in the loading
vector c,. Repeat doing this for all M columns of quality variables:

c.=(1/cca) Ya' ¢a (9.28)

Step 5. Regress each of the J rows in quality matrix Y, onto to the weight vector c.. Large weight
coefficients indicate rows in Y, are strongly correlated with c..

u,=(1/c'ca) Ya' ¢z (9.29)



The NIPLAS algorithm then continues with a procedure called “deflation” to remove variability already
explained in X, and Y.. This involve two steps.

Deflation Step 1. Calculate a loading vector for the X space.
We calculate a loading vector p, using the X-space scores, following Egs. (9.7) - (9.8):
pa=(1/ t.t) X" ta (9.30)

Here, the score vector t, is normalized. This loading vector p, contains the regression slope of every
column in Xa onto the score vector t.. In this regression, the score vector t,is the x-variable, the column
from Xa is the y-variable.

Deflation Step 2. Remove the predicted variability from X and Y.

Using the score vector t, and the loading vector p,, we follow Eq. (9.19) to calculate the predicted value
of X,, denoted by )?a:

=

R=ta s (9.31)

We then remove this best prediction )?a from the X,, that is, we remove the variability already explained
well from the original data matrix Xa:

Ea=Xa_:X\a=Xa‘ta p’a (9-32)
We define the remaining data matrix as Xa«1:
Xa+1= Ea (933)

In the same way, we remove the variability from the quality data matrix Y, using the score vector t, and
the leading vector ca.

Yo=t.c (9.34)
Fa= Y.-Y,=VY.-t. s (9.35)
Y= Fa (9.36)

The NIPALS algorithm repeats all over again using the deflated matrices for the subsequent iterations.

In Appendix B of this book, code B.5 and Table B.1 at the end give the Python implementation of the PLS
algorithm, together with a list of common parameters and their suggested values.

9.4 Hands-on Workshops of PLS of LDPE and HDPE Processes

9.4.1 Workshop 9.2: PLS of Process and Quality Variables Affecting the Quality and Conversion of LDPE
Product from a Two-Zone Tubular Reactor

The procedure to carry out this workshop is similar to WS9.1_PCA-X in Section 9.2. We only highlight
the changes to the previous workshop when considering both X and Y spaces (i.e., process and quality
variables).



We follow Figure 9.11 to start a new project, and follow Figure 9.12 to import data from file, LDPE.xlIs,

but to choose both process variables and product quality variables. We change Figure 9.14 to Figure
9.32.
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Figure 9.32 Specify block types for process variables, X, and product quality variables, Y.

After importing the data file, LDPE.xls, we note that the original reference [18] for the LPDE data
indicates that some observations, such as observation IDs from 51 to 54, reflect a gradual increasing
level of impurities in the feed ethylene to both zones of the tubular reactor, and they progressively
move outside the acceptable region. Additionally, the values for observation IDs from 51 to 54 do not
change for most of the 15 process variables. See Figure 9.33, in which the data plot on the right results
from our highlighting process variable 3 on the left. Next, we see an observation summary in Figure 9.34
(similar to Figire 9.15), in which we delete observations 51 to 54.
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Figure 9.33 A display of observed values for process variable 3.
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Figure 9.34 Delete observations 51 to 54

We save the project file as W59.2_PLS-XY.pmvx. In the following, we demonstrate the PLS model plots
for the quality variable or Y-space, focusing on those new plots that we did not illustrate in Section 9.2,
Workshop 9.1 with the PCA model.

(1) PLS model for the Y-space

We follow the path: Model -> Active Model ->Auto Fit (follow Figure 9.20), and see the resulting model
of Figure 9.35, displaying the R2 and Q2 values, Eq. (9.19) and (9.20), versus the number of principal
components. As demonstrated in Figure 9.21, we can right-mouse-click on the R2-Q2 plot and select
“Create Table” to see a table of R2 and Q2 values in the plot. An R2 value of 0.9654 indicates that the
PLS model for Y-space will explain 96.54% of the variability of the dataset for product quality variables
with 6 principal components. A Q2 value of 0.9474 says that with cross validation, the model can explain
94.74% of the variability of the dataset for product quality variables.
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Figure 9.35 R2 and Q2 values of PLS for Y-space with six principal components resulting from auto fit

Following Figure 9.19 and choosing the # button on the top of the screen and filling in a maximum
number of 7 principal components, we get a R2-Q2 plot of Figure 9.36. It appears that adding one
principal component increases the R2 value from 0.9654 to 0.9712, and Q2 values from 0.9473 to
0.9566. We will use 7 principal components in the example below.
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Figure 9.36 R2 and Q2 values of PLS for Y-space with seven principal components

(2) Model variable summary for the Y-space

Next, we follow the path: Analyze ->Model -> Variable Summary -> Choose Block: y-space, and
Component: 7. We see in Figure 9.37 that except for Mw (or MWW) (weight-average molecular weight),
the PLS model for Y-space predicts CONV, Mn (or MWN), LCB and SCB reliability with R2 values above
0.9842.
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Figure 9.37 R2 and Q2 values of PLS for Y-space with seven principal components
(3) T1-T2 score plot and W*C[1] vs W*C[2] loading plot

The T1-T2 score plot used to identify clusters and outliers, previously shown in Figure 9.25, applies to
both PCA model for the X-space and PLS model for the X and Y spaces. For the PLS model, it is best to
use the W*C[1] vs W*C[2] loading plot, because it also explains the relationship between the X and Y
variables.



By choosing W*,c1-W*,c2 button on the left side pane, we generate the preferred PLS loading plot on
the right side of Figure 9.38. In the plot, we see 5 quality variables or Y variables in red, and 14 process
variables or X variables in black. Referring to the variable definitions in Table 9.1, Section 9.2, we see
that the quality variable SCB in red is positively correlated with process variables Fil and Tmax1; quality
variables Mw, CONV and LCB in red are negatively correlated with process variables Fi2, Tout2 and
Tmax2 in black; and quality variable Mn in red is also negatively correlated with process variables z1 and
Tcin2 in black.
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Figure 9.38 T[2] vs T[1] score plot and W*C[1] vs W*C[2] loading plot

(4) Loading bi-plot

A loading bi-plot super-imposes the loadings and scores, such as Figure 9.38 (left and right) for easier
interpretation of the relationship between the variables and observations. Following the path, Analyze -
> Loading bi-plot ->Worksets: training, Block: X-space; X-axis: component 1; Y-axis: component 2, we
generate a loading bi-plot of Figure 9.39.
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Figure 9.39 Loading bi-plot
(4) Obs vs pred plot

By choosing obs vs pred on the left-side pane and specifying the following: worksets- training;
observation - 1; block - product quality variable; variable- Mn; component:7; raw units, we generate the
Obs vs pred plot of Figure 9.41. The root-mean-squared-error (RMSE) of 35.5144 is only 0.013% of the
average observed value of 27400.
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Figure 9.41 Obs. Vs Pred. plot of product quality variable, Mn (number-average molecular weight)
This concludes workshop WS$9.2_PLS-XY, and we save the file as WS59.2_PLS-XY.pmvx.

9.4.2. Workshop 9.3 - Polymer Melt Index Prediction and Causal Analysis Using PLS

The objective of this workshop is to demonstrate the application of PLS model for predicting the Ml and
causal analysis of a HDPE manufacturing process. We consider an industrial slurry HDPE process with
two reactors in parallel with the model details as defined by Sharma and Liu [28,43,44], using plant data
from LG Petrochemicals in South Korea [21]. See Figure 9.42.
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Figure 9.42 Process simulation flowsheet of an industrial parallel slurry HDPE process



We convert a steady-state simulation model based on Aspen Plus to a dynamic (time-dependent)
simulation model using Aspen Plus Dynamics. The resulting dynamic simulation model has similar
independent variables as explained before. Both steady-state and dynamic simulation models are
developed from first principles such as phase-equilibrium calculations and mass and energy balances.
Therefore, they are scientifically consistent models.

Park et. al. [21] correlate the MI data by considering the independent variables shown in Table 9.2. The
dataset consists of 5000 observations and 9 main independent process variables and 1 dependent
variable, M, as the quality target. We first make sure the data are in Excel format and the process
variable (X) and (Y) data are in different sheets within HDPE_XY Data.xIsx.

Table 9.2 Process and quality variables of the parallel slurry HDPE process

Process and quality variables Description

C2 Ethylene feed flow rate

H2 Hydrogen feed flow rate

CAT Catalyst feed flow rate

HX Hexane solvent feed flow rate

C3 Comonomer feed flow rate

T Temperature of the reactor

P Pressure in the reactor

H2/C2 Feed concentration ratio in the reactor of ethylene to
hydrogen

C3/c4 Feed concentration ratio of Propylene to Butylene monomer

MI (quality variable) Melt Index of polymer

We open a new project in Aspen ProMV. Following Figure 9.27 in Workshop 9.2, we import both process
(X) and quality (Y) variable datasets, HDPE_XY Data.xIsx, into Aspen ProMV. On the data manager, we
choose the X block and highlight all “Obs ID” for X vailables to “Include” all X obsrvations (see Figure
9.43). Clicking on OK in “Observaton Summaey” leads to the “New Model” screen, and choosing the X
block generates the details of 9 process variables, including their mean, standard deviation, min/max
value, etc. (see Figure 9.44). Likewise, choosing the Y block shows the details of the single quality
vailable, Ml (see Figre 9.45). We then name the new model as WS$9.3_PLS-XY.pmvx.
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Figue 9.43 Highlighting all X variable Obs ID in “Observation Summary” to include all observations
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Figure 9.44 Process variable details in the new model.
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Figure 9.45 Quality variable details in the new model.

(1) PLS Model for the Y-space



We follow the path: Model ->Active Model -> Auto Fit (follow Figure 9.20), and see the R2 and Q2 values
of the resulting model in Figure 9.46. The figure shows that with four principal components, an R2 value
of 0.9534 says that the PLS model can explain 95.34% of the variability of the product quality variable,
the melt index (MI); a Q2 value of 0.9533 means that with cross validation, the PLS model can explain
95.33% of the data variability.
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Figure 9.46 R2 and Q2 values of PLS for Y-space with four principal components resulting from auto fit.

(2) Obs vs Pred plot

Following Figure 9.41, we generate a Obs. Vs Pred plot in Figure 9.47. The root-mean-squared-error
(RMSEE) is 1.08266.
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Figure 9.47 The Obs vs pred plot with 4 principal components

(3) Loading bi-plot and VIP plot

Following Figure 9.39, we show a loading bi-plot, super-imposes the T[2] vs T[1] score plot and W*c[1]
vs W*c[2] plot in Figure 9.48.
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Figure 9.48 Loading bi-plot

We see that from the scores, T[2] vs T[1], process variables CAT and H2/C2 in black are both outside the
99% confidence limit, and are potentially outliers. Additionally, quality variable, MI Plant, in red is
positively correlated with process variables H2, H2/C2 and CAT in black (since they lie nearer to each
other). We can confirm this strong correlation by selecting the VIP button on the left side pane to

generate a variable importance to projection plot, VIP, in Figure 9.49.
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Figure 9.49 Variable importance to projection, VIP plot

(4) Hotelling’s T? plot

Following Figure 9.26, we show the Hotelling’s T2 plot in Figure 9.50, and want to demonstrate new tools
to identify the cause of a selected outlier in our dataset. We right-click within the plot to show the menu
to display observation number. We click on “Display Point Tooltips”, and then put the mouse on one of
the outliers. We see in Figure 9.51 the observation number as 2697.
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Figure 9.50 The Hotelling’s plot and the menu to display observation number., “Display Point Tooltips”.
The data points within the red circle represent potential outliers outside the 95% confidence limit.
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Figure 9.51 Displaying data number 2697 for an outlier located on the far right, top data point
How do we identify the cause of data number 2697 as an outlier? We use the contribution plot below.
(4) Contribution plot

We follow the path: Analyze -> Contributions -> Specify according to Figure 9.52 -> Contribution plot of
Figure 9.53.
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Figure 9.52 Specifying a contribution plot from average to data point 2697.
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Figure 9.53 Contribution plot indicating temperature of data pint 2697 being much lower than the
average value, causing an outlier in the Hotelling’s T2 plot

Next, we start a new project, import the data file, HDPX_XY_Data.xIsx, again. We then follow Figures
9.15-9.16, and Figure 9.34, to remove observation IDs 2412 to 2415, and 2695 to 2698 (potential
outliers highlighted within the red circle in Figure 9.50), and save the resulting model file as WS$9.3-
1.PLS-XY.pmvx. Following the path: Model -> Active Model -> Auto Fit, we generate the model resulting
from removing observation IDs 2412 to 2415, and 2695 to 2698. Figure 9.54 shows the corresponding
R2-Q2 plot and the Obs vs Pred plot.
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Figure 9.54 The R2-Q2 plot and Obs vs Pred Plot after removing potential outliers.



Comparing Figures 9.47 and 9.54, we find the change of R2 from 0.953395 to 0.9534, and RMSE from
1.08266 to 1.08267 quite insignificant. Therefore, we can stay with the original model. This concludes
workshop WS59.2_PLS-XY, and we save the file as WS9.2_PLS-XY.pmvx.

9.5. Workshop 9.4 - Polymer Melt Index Prediction and Causal Analysis with Measurement Time Lags
Using PLS

9.5.1 Introduction to PLS with Measurement Time Lags

In many chemical processes, there is some lag between the time when the quality variable like Ml at the
process outlet is measured and the process variable measurements. The output in a dynamic process is
related to the past process variable inputs and past outputs as well. To handle the autocorrelation data,
we mimic the concept of auto-regressive moving average exogenous (ARMAX) time series models by
forming the data matrix with previous observation in each observation vector. The time series model
which relates quality (dependent) variable y at present time to past quality variable y’s and process
(independent) variable x’s.

The model equation is represented below:

Ve = B1Ye-1+ BoYi—2 + -+ ViXe—q +VaXez + € (9.37)

This eventually means that we need to use a lagged value of the quality variable to account for the time
lags. Thus, we consider the autocorrelation in the data in ProMV by introduction of the lag of variable
order. This time series modeling technique is also referred as PLS with observation time lags. When
applied the technique to batch processes with time lags, Chen and Liu [21] refer the method as batch
dynamic partial least squares (BDPLS).

When a quality (Y) variable in a PLS model contains measurement time lags, we introduce a lagged
quality variable to the Y block to which it belongs. Following Aspen ProMV online help, we show in
Figure 9.55 an example of a Y data block with a single quality variable that is lagged three time units. In
the figure, we add three lagged quality variables. The resulting quality data block with lags (called LagsY
block) now has three more variables due to time lags, but three fewer observations. We define a lagged
variable with the original name with the suffix _L#, where # represents the lag value for that particular
value.

Quality 1
Variable 2
Observation 3 Observation Data
Data —_— with Lags
(Y) (LagsY)

Lagged Quality Variables

Figure 9.55 An illustration of a single quality variable that is lagged three time units.
In the following, we demonstrate how to apply PLS with observation time lags using Aspen ProMV.

9.5.2 Workshop 9.4 - Application of Aspen ProMV to Polymer Melt Index Prediction and Causal
Analysis with Measurement Time Lags Using PLS



We use the same industrial HDPE process in Workshop 9.3 in Section 9.4.2, and the same industrial
dataset, HDPE_XY_Data.xIsx.

We load the data using the same procedure. In this case we introduce a lag of order 1 in both the input
process variables and the process output M, so that the Ml at the current time is function of the
historical value of process variables and past Ml value.

We follow the steps from Figures 9.12 to 9.18, but import both process and quality variable data (X and
Y spaces) as in Figure 9.32, and save the file as WS59.4_PLS-X and LagsY.pmvx. In the New Model screen,
we pay attention to the “Lags” button. See Figure 9.56.
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Figure 9.56 The “Lags” button in the New Model screen

Referring to Figure 9.57, we choose quality variable, Plant MI, specify a lag of 1 time unit, and use the
arrow key to move the data to the LagsY block on the right. We then save the model file as WS9.4_PLS-
X and LagsY.pmvx.
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Figure 9.57 Specifying a lag of one time-unit for the quality variable, Ml Plant.
The new variable is named Ml Plant_L1.

We build a PLS model following the path: Model ->Active Model ->Auto Fit (Figure 9.20) and see the
resulting PLS model with time lag in Figure 9.58. An R2 value of 0.9938 says that the PLS model with
time lag can explain 99.38% of the variability of the quality variable, Plant MI (melt index); a Q2 value of
0.9938 says that with cross validation, the model can explain 99.38% of the data variability. From Figure
9.46, we see that the corresponding R2 and Q2 values without time lag are 0.9534 and 0.9533,



respectively. This comparison shows that by introducing the time lag, both R2 and Q2 values increases
significantly when compared to those values without time lag.
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Figure 9.58 R2 and Q2 values of PLS for Y-space with time lag with four
principal components resulting from auto fit.

Following Figures 9.41 and 9.47, we generate an Obs vs Pred plot in Figure 9.59. It is significant to note
that by adding a time lag, the PLS model significantly lowers the RMSEE value from 1.08266 without
time lag (Figure9.47) to 0.393567 with time lag (Figure 9.59).

Figure 9.60 shows a VIP plot for the PLS model with time lag. By comparing this plot with the
corresponding VIP plot without time lag, Figure 9.49, we see that the lagged quality variable, Plant M,
becomes the most important variable for the PLS model with time lag.
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Figure 9.59 The Obs vs Pred plot with 4 principal components and with time lag

Observed

Thus, we can actually use the data from PLS model and separately plot the results with the actual plant
data. Figure 9.60 demonstrates that predictions from a PLS model with measurement time lag compare

well with the time-dependent plant Ml data.
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Figure 9.60. Development of a soft sensor of Ml based on Causal PLS model

This concludes our workshop 9.4, and we save the resulting simulation file as W59.4_PLS-X and
LagsY.pmvx.
9.6. Multiway PCA and PLS for Batch Processes

9.6.1 Batch-Wise Unfolding and Observation-Wise Unfolding Approaches to Multiway PLS

Our discussion of data analytics in the preceding sections has been mostly for continuous processes. For
data analytics of batch processes, we require a different approach. Industrial batch process data with
multiple batches have a three-dimensional structure with the three data dimensions, namely, process
variables, time, and number of batches. Nomikos and Macgregor [22] explained those three data
dimensions as an example of a multiway approach to multivariate data analytics, and they specifically
demonstrated two approaches when applied to PCA or PLS.

The first approach is the batch-wise unfolding (BWU) approach that extracts the batch trajectory
observations horizontally in a time-wise manner, as illustrated in Figure 9.61. Each batch becomes a
single row of data. In the figure, we have a three-way array of trajectory data (X) of i = 1 to | (number of
batches), j = 1 to J (number of process variables), and k = 1 to K (time step of data observation). We also
append an initial condition matrix Z and a product quality matrix Y at time k =0 (beginning time) an k=K
(ending time), respectively. In BWU, the data are unfolded into a two-way array X (I x J by K), where the
rows of the unfolded matrix represent the batches. Each batch becomes a single row of data in the
model.

We develop PLS models based on the unfolded data matrices. The BWU principal component score
predicts the final state of each batch based on all the time history of that batch to the current time. The
resulting principal component scores show differences among batches. The BWU approach is useful to
predicting the final product quality, monitoring, control and optimization of batch processes.
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Figure 9.61 An illustration of batch-wide unfolding (BWU) of the 3-way (I x J x K) array of trajectory data
(X) of i =1 to | (number of batches), j = 1 to J (number of process variables), and
k =1 to K (time step of data observation).

Refer to our discussion of PLS in Section 9.3.1, particularly Egs. (9.17), (9.23) and (9.24), and to Figure 9.30.
We show in Figure 9.62 an extension of the PLS structural digram to batch-wise unfolding. In the figure, Z
is the initial condition vector, X is the process data matrix, Y is the quality data matrix, T is the principal
component score matrix, V' is the initial condition vector, W is the weight matrix, and CT is the principal
component loading matrix. Based on Figure 9.30 and Eq. (9.24), we write the principal component score
matrix T and the predicted product quality matrix ¥ as:

T=XW (9.24)
Y=TC =[XW]C" = X[WC"]= XB (9.24a)

where B is the regression coefficient matrix of PLS. We have a row of coefficients for each Y variable. These
coefficients show the relative importance of the X’s to each individual Y variable.
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Figure 9.62 PLS of batch-wise unfolded data.

The second approach is the observation-wide unfolding (OWU) approach where the process data for
each batch are stacked on top of one another, following the way we typically read batch data. The
analysis will summarize the instantaneous condition of each batch using the measured values at the
current time. The study by Nguyen et al. [30] compares the two batch folding techniques BWU and OWU



for analysis of foaming in a fermentation process. Figure 9.63 illustrates the OWU approach, which is
useful to reducing the dimension of data collected from batches.

k=1
Batch TITTTE Batch 1
Observations
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K Batch 2
T"me/'
0 - . i .
0|0 variables ] !
Batch }/
| Batches Trajectory
| Data (X) \“R_ﬁ‘—*—b Batch |
v

Figure 9.63 An illustration of observation-wise unfolding (OWU of of the 3-way (I x J x K) array of
trajectory data (X) of i =1 to | (number of batches), j = 1 to J (number of process variables), and
k =1 to K (time step of data observation).

9.6.2 Workshop 9.5 - Application of Aspen ProMV to Batch-Wise Unfolding (BWU) Approach to
Multiway PCA of Batch Polymerization Data

We consider a polymer batch dataset (polymer.xls) provided by Dunn [19] consisting of ten process
variables X (j =1 to 10) in 55 batches (j = 1 to 55). Within each batch, we have 100 time steps of data
observations (k = 1 to 100). We use PCA along with BWU analysis to identify the abnormal/bad batches
using Aspen Pro MV.

We first load polymer.xls as follows. Start Aspen ProMV and select “New Project”. Within the Data
Manager, we choose “Batch Blocks”, and then click on “Import Batch Block” to upload polymer.xlis into
the software. Figure 9.64 shows part of the imported data with 10 process variables in different batches.

B Import Batch Data From File - ]
1 2 3 4 5 6 7 3 9 10 11
DETnelDalablRous) BWU BWU BWU BWU BWU BWU BWU BWU BWU BWU BWU
1 Batch Num... X1 X2 X3 X4 X5 X6 X7 X8 X9 X10
Variable Ds | Single Row
210 057039 0.887247 0546655 098417 05202 0989112 0933139 0954723 0.727997 1.387073
Var. Sec. s | Multiple Raws 310 0576384 0.862227 0552975 0979343 07248 0989199 093337 0956171 0.72632 144286
4 10 0582171 0823841 0559798 0975297 07837 0989719 0.933601 0956344 0.728416 1487092
Data Multiple Rows 5 10 0589163 0795793 0566655 0976823 08186 0989834 0933804 095481 0.734842 1.511825
6 10 0597086 0779892 0573479 0975901 07854 0988592 0934498 0954781 0.740011 1.523741
Bire P2 = EE b 7 1.0 0.605835 0.770938 0.581277 0.975901 0.8064 0.988477 0935511 0.955707 0.739033 1538545
Observation s Sinale Column 8 10 0614619 0.76567 0589345 0977285 08139 0989574 0936524 0956257 0.740011 1.537281
9 10 0622714 0761555 0597076 0975581 07811 0990239 093716 0957039 0.74518 1.515797
B | scooncery s | Muitivle Golumns
10 10 0630671 0759415 0604807 0974942 0.7909 0990556 0937536 0959008 0.748952 1490522
Il | Froses | Sigle Column 110 0639454 0758625 0612538 0976149 07979 0990874 0937912 0960252 0.751746 1462719

Figure 9.64 A part of the imported batch polymerization dataset.

We then choose the batch number column (column1) and click on “Observation IDs” button on the left
side pane to designate column 1 to contain Observation IDs. For batch dataset, one “observation”
represents a batch. Referring to Figure 9.65, we can explain how the three-way database is displayed.



First, we see that the column to the left of the Observation ID (i.e., batch number) goes from 2 to 5501
(currently displaying columns 2 to 3, 100 to 103, and 5498 to 5501 in the figure), which represents a
total of 5500 time steps of data observations, with each observation ID or each batch number containing
100 time steps (that is k = 1 to 100) from 2 to 101 for batch 1, 102 to 201 for batch 2, 202 to 301 for
batch 3, ...., and 5402 to 5501 for batch 55.

Next, we see column 1 (ObsIDs), Batch Number, varies from 1 to 55 (that is, i = 1 to 55). Lastly, we see
Columns 2 to 11 for X1 to X10, representing 10 process variables (that is, j = 1 to 10).

1 2 3 4 5 6 7 8 9 10 1

ObsiDs BWU BWU BWU BWU BWU BWU BWU BWU BWU BWU
1 [eatehNum.. | x1 x2 X3 X4 X5 X6 X7 X8 X9 X10
2 ﬁ 057039 0887247 0546655 098417 05202 0989112 0933139 0954723 0727997 1387073
3 WOBMN 0576334 0862227 0552075 0979343 07248 0989199 093337 0956171 072632 144286
100 WONMN 0946678 0969153 0925244 0411203 00 086282 0684238 0858061 0437273 00
101 JONMIN 0952396 0969384 0926992 0415084 00 0860972 0678943 0857308 0433641 00
100 GONMNNNNN 0561848 0885173 0537042 0941331 01247 0988564 0932068 0954694 0723945 129536
103 SOMMNNN 0566978 0891526 0541479 0984845 04529 0988332 09323 0954578 0722688 1369561
5498 _ 0.939995 0.954471 0.919361 0.403691 0.0 0.869607 0.83017 0.844947 0.387119 0.0
sa00 BSOMMNNNN 0040305 0955261 0919899 0407631 00 0867585 0827682 0843181 0385303 00
ss00 SSOMMMNN 0040546 0955359 0920874 0406247 00 0865563 082502 084138 038656 00
ss01 SHOMMMMNN 0940822 0954866 092195 0412067 00 086337 0822387 0839562 0378737 00

Figure 9.65 A display of parts of the unfolded dataset

On the same window screen of Figures 9.64-9.65, we click on OK, and then choose “No” to align the
batch trajectory. See Figure 9.66. We then see the “View/Edit Batch Block” screen, and we highlight
column 1 and see the time-dependent change of variable X1 over the 100 time steps within batch 1. See

Figure 9.67. We click on “Save”.

B Aspen Promv
g This batch data has the same number of observations per
L Dbatch, but it may still need alignment to ensure that the
important events in each batch are lined up.

Would you still like to go through the Alignment Tool?

tes

Figure 9.66 Option to align the batch trajectory
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Figure 9.67 A display of the time-dependent changes of variable X1 for 100 time steps in batch 1

B Data Manager >
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Figure 9.68 A summary of imported dataset

We click on OK on the screen of Figure 9.68 and see the Observation Summary (as illustrated previously
in Figure 9.15) and then click on OK. We save the resulting file as W59.5_PCA_BWU-X.pmvx.

Following Figures 9.20, we develop a PCA model of the batch-wide unfolded dataset with 10 principal
components (A = 10). Figure 9.69 shows the resulting R2 and Q2 values versus the number of principal
components. We note that both R2 and Q2 increase with an increase in the number of principal
components. Should we choose to use auto-fitting tool following Figure 9.20, the number of principal
components (A) is equal to half of the total number of process variables (j= 1 to 10), that is, A= 5. The
corresponding R2 and Q2 values are 0.7049 and 0.6096, respectively.
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Figure 9.69 R2 and Q2 values versus the number of principal components



Following Figure 9.25, we show in Figure 9.70 the score plot, T[2] vs T[1], for the case with 5 principal
components. In the plot, we use the button highlighted by an arrow on the top ribbon to select points
located close to the 95% confidence limit (dashed ellipse), batch 51; points located between 95% and
99% confidence limits (dashed and solid ellipses), batches 50,52,53 and 55; and point outside the 99%
confidence limit, batch 54. These batches represent the apparent outliers or abnormal batches among

the 55 batches (i = 1 to 55).
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Figure 9.70 Score plot, T[2] vs T[1]

We confirm batches 50 to 55 being abnormal by following Figure 9.26 to draw the Hostelling’s T? plot in
Figure 9.71. Significantly, this plot shows another abnormal batch 49 that is not apparent in Figure 9.70.
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Figure 9.71 The Hostelling T? plot

Following Figure 9.27, we show in Figure 9.72 the squared prediction error SPE-X plot, which reveals
that batch 51 has the largest SPE-X.
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Figure 9.73 The SPE-X plot

We conclude this workshop by finding out what happens when applying the observation-wide unfolding
(OWU) approach to the same polymer dataset. We first load polymer.xls as follows. Start Aspen ProMV
and select “New Project”. To use OWU on the same dataset, we need to import batch data using
“Standard Blocks” within the Data Manager, not “Batch Block” (see Figure 9.14 shown previously). Since
the dataset (polymer.xls) contains 55 batches with each batch containing 100 time steps, following the
same procedure as in the BWU approach will lead to the error of having “duplicate Observation IDs”
(see Figure 9.73). We need to do some manipulations of the dataset to prevent the error. We use the
Pandas package in Python (see Appendix 9.1) to delete the “Batch Number” column in the Excel sheet
and add an index column from one to 5500 observation instances. This column serves as “Observation
IDs” for data import by “Standard Blocks”. We save the Excel file after data manipulation as
Polymer_OWU_No duplicate ObsIDs.xls.

1 z 3 4 = N
ObslDs BWU BwWU BWU L]
1 Batch Num... X1 x2 X3
2 1.0 0570329
B Aspen ProMVv 7 >
3 1.0 0.576384
A 1.0 0.582171 The following errors must be resolved:
5 1.0 0.589163 There are duplicate Observation IDs: -~
1.0 atrows 2, 3,4, 5,6, 7, 8,9, 10,
=1 1.0 0.597086 11,12, 13, 14, 15, 16, 17, 18, 19, 20,
21, 22, 23, 24, 25, 26, 27, 28, 29, 30,
7 1.0 0.805835 31, 32, 33, 34, 35, 36, 37, 38, 39, 40,
41,42, 43, 44, 45, 46, 47, 48, 49, 50,
a 1.0 0.614619 s1, 52, 53, 54, 55, 56, 57, 58, 59, 60,
61, 62, 63, 64, 65, 66, 67, 68, 69, 70,
e 1.0 0.622714 71, 72, 73, 74, 75, 76, 77, 78, 79, 80,
81, 82, 83, 84, 85, 86, 87, 88, 89, 90,
1o 1.0 0.630671 91, 92, 93, 94, 95, 96, 97, 98, 99, 100,
11 1.0 0.639454 —
2 1o 0.64996

Figure 9.73 Error of having duplicate Observations IDs

We use the Pandas package in Python (see Appendix 9.1) to delete the “Batch Number” column in the
dataset Excel sheet and add an index column from one to 5500 observation instances. This column
serves as “Observation IDs” for the “Standard Blocks” data import. The file after data manipulation is
saved as, Polymer_OWU_No duplicate ObsIDs.xls.

We now follow Figures 9.11 to 21 to develop a PCA model using standard blocks with the modified
dataset, Polymer_OWU_No duplicate ObsIDs.xls. Figure 9.74 shows part of the imported dataset, and



we do not see the error of having duplicated observation IDs. We save the resulting PCA model as
WS9.5_OWS_PCA-X.pmvx. Figure 9.74 shows the resulting R2 and Q2 versus the number of principal
components, and Figure 9.75 gives the corresponding score and loading plots. It is unfortunate that the
score plot of Figure 9.75 (left) shows no interpretable trends and no observable outliers with the OWU
approach.This is in contrast to the outliers (batches 50 to 55) depicted in the score plot of Figure 9.70
resulting from applying the BWU approach. The loading plot on the right of Fgure 9.75 shows some
variabes located closely together that are correlated, and some variables that lie on the opposite sides
of the plot that are negatively correlated.
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Figure 9.76 T[2] vs T[1] score plot and P[2] vs P[1] loading plot

We conclude that the batch-wise unfolding (BWU) approach is more effective than observation-wise
unfolding (OWU) for batch data analytics.

9.7 Implementation of Multivariate Statistics Models

Should the reader wish to extract the equations and coefficients from of developed PCA and PLS models
from Aspen ProMV to implement elsewhere, follow the path: Model -> Export Model ->Model List -
>Model 1 -> Included in Export -> Training, Batch, Monitoring and Alignment Data -> Excel, e.g.,

WS9.2 PLS-XY_WS9.2 PLS-XY.xlsx. Figure 9.76 shows an information summary of the model.
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Figure 9.76 An information summary of the exported model

For the example, we see the following Excel folders of the exported model:

| Information | Scores | P | W | WStar | B_Conv | B.Mn | B.Mw | BLLCB | B_.SCB | Y-Weights | Preprocessing

The various sub-folders in the exported Excel model are as follows.

(1) Scores (T) and loadings (P): See Egs. (9.8) and (9.17); Figures 9.25 and 9.38.

(2) Weights (W): See Eq. (9.24).

(3) Weights (WStar; W*): See Figure 9.38.

(4) Regression coefficients _Conv, B_Mn, B_Mw, B_LCB and B_SCB: Eq. (9.38)

(5) Y-Weights: See Figure 9.77 below.
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Figure 9.77 Weights for Y-space.

W=, c[1]

If you do not have Aspen ProMV for outlier or anomaly detection, consider using Python that we
introduce in Appendix B, Introduction to Python for Chemical Engineers, and refer to Section 10.1.3,
Suggested Resources to Get Started with Machine Learning. Adopt the open-source Scikit-Learn PLS



library for model building and getting the model coefficients:
https://scikitlearn.org/stable/modules/generated/sklearn.cross decomposition.PLSRegression.html

Additionally, In Section 10.2.3 and Table 10.5 of Chapter 10, we introduce additional machine learnng-
based methods for outlier or anomaly detection, which can be implemented by Python. Two of the
popular methods are Density-Based Spatial Clustering of Applications with Noise (DBSCAN) (Section
10.2.3.d) and Gaussian mixture model (GMM) (Section 10.2.3.e).

Most of the multivariate statistical models in this chapter and machine learning models in Chapters 10
and 11 use historical data. For online implementation, we need a real-time plant historian, such as
Aspen InfoPlus.21 and Aspen Process Explorer, to demonstrate online model deployment. For example,
Aspen Technology, Inc. has several software tools, such as Aspen Process Pulse™ and Aspen Scrambler™
to enable the monitoring, controlling, and optimizing processes with real-time visibility of all types of
process and spectral data. Interested readers may refer to Sharmin et al. [27] about a PCA-based fault
detection scheme for an industrial high-pressure polyethylene reactor using Aspen Process Explorer.

9.8. Conclusion and Suggested Resources for Further Studies

In this chapter, we have showcased the utility of latent variable models like PCA and PLS for causal
analysis to identify correct correlations between input and outputs for polymer process application. We
identify the Dynamic PCA and PLS model utility in dynamic time series process data by considering the
measurement lags. We also demonstrate the methodology for batch-wise unfolding (BWU) and
observation-wise unfolding OWU) analyses of batch data.

For further studies, we recommend references [24] to [26] in the bibliogrphy below. We discuss a
number of topics together with their relevant references below.

Gracia-Munoz et. al. [24] discussed the issue of time allignment in batch proesses. Specifically, in many
batch processes, batches can be of different time durations within certain phases or across the entire
batch evoluation. A search of Aspen ProMV online help gives the details and examples of alignment
tools and their implementation in batch processes.

Park et. al. [21] and Han et. al. [25] presented interesting case studies of applying PLS and machine
learning tools (support vector macines and artificial neural networks) to modeling the melt index of
high-density polyethylene (HDPE), styrene-acrylontrille (SAN) and polypropylene (PP) processes
operating in Korea.

Chen and Lu [26] integrated auto-regressive moving average (ARMAX) exogenous time series model
with PCA model, and called it dynamic PCA (DPCA) that involves the use of time lags which we discussed
in Sections 9.5.1 and 9.5.2. They also combined three-way observation-wise unfolding PLS (Section
9.6.1) with time-lagged windows, and called it batch dynamic PLS (BDPLS). They applied both methods
to industrial batch polymerization datasets. One of the future idea is to combine the multivariate
statistics with science and process knowledge in hybrid methodology for process improvement as shown
Sharma & Liu [29,45].

This chapter is published with Wiley publication in the book Integrated Process Modeling, Advanced
Control and Data Analytics for Optimizing Polyolefin Manufacturing by Liu & Sharma.
[31,32,33,34,35,36,37,38,39,40,41,42]


https://scikitlearn.org/stable/modules/generated/sklearn.cross_decomposition.PLSRegression.html
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